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Welcome to TradeStation FuturesPlus 
This guide introduces you to some of the main features in the FuturesPlus platform.  

For more in-depth help, visit the Support tab (see page 29), or watch the how-to videos on 

https://www.tradingtechnologies.com/resources/training-videos/.  

Read on to learn how to get started with this robust platform, including using special built-in workspaces 

like these, designed by TradeStation experts (see page 6). 

Futures Options Trader Workspace 

 

 

 

 

 

 

 

 

Futures Spread Trader 
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Futures Trader 
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Get ready for the next generation of futures options trading…  
Thank you for choosing TradeStation!  

https://www.tradingtechnologies.com/resources/training-videos/
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Logging in 
To log in to the TradeStation FuturesPlus web application: 

1. Open your web browser. Google Chrome, Mozilla Firefox, and 

Microsoft Edge browsers are supported. 

a. Access FuturesPlus from your Tradestation Client Center 

home page or directly from 

futuresplustt.tradestation.com. 

b. At the login screen, enter your TradeStation Client Center 

username and password. 

2. The first time you log in, agree to the Customer Service 

Agreement, and then TradeStation FuturesPlus will open and 

initialize for you. 

3. When you first login, a window appears with tools to get you 
started.  

a. Launch a digital tour that walks you through the main features in TradeStation 

FuturesPlus.  

b. Visit links to help topics on key features. 

c. Choose a workspace that has been designed by TradeStation experts, with the widgets 

already laid out for you, or 

d. Create your own workspace from scratch. 

 

Tip: You can launch the digital tour, open the built-in workspaces, create new workspaces, and view the 

workspaces you’ve already created under the File menu. 

Welcome to TradeStation FuturesPlus! 

http://futuresplustt.tradestation.com/
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Workspace windows 
A workspace is comprised of one or more windows that contain widgets tailored to your trading 

preferences.  

After adding a widget to a workspace, you can drag the widget by its title bar to another location on the 

workspace. When you drag a widget near another widget, it automatically snaps to the edge of the 

stationary widget to help you align the widgets.  

Each widget contains a set of icons in the top-right corner that allow you to minimize, maximize or close 

the widget. When you are done opening and arranging widgets, save the workspace by clicking the Save 

icon in the workspace menu bar. 

Workspace Window Menu Bar 
The workspace window menu bar appears at the top of each main window and provides access to 

general workspace functionality. 

 

The main window menu bar includes the following: 

1. File menu — Includes items for creating, opening, and managing workspaces and creating 
templates. Also provides access to information about your connection and lets you refresh the 
workspace in your browser. 

2. Edit menu — Provides access to your global settings and allows you to change trading 
environments. 

3. Widgets menu — Shows a list of all widgets currently available in your environment. 

4. Search — Allows you to search for products and instruments. 

5. Market Explorer — Allows you to find products and instruments. 

6. Opened widgets — Provides quick access to all widgets currently opened. 

7. Windows selector — Allows you to add multiple windows and select existing windows within 
your workspace. 

8. Clock — Displays the time at your current location. 

9. Save workspace — Saves the current layout of your workspace. 

10. Support screen — Provides access to online documentation and support. 

11. Connection status indicator — Shows your connection status. 

12. Lock screen icon — Allows you to lock and unlock your workspace. 
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Opening a built-in workspace  
FuturesPlus provides built-in workspaces that have been designed by TradeStation experts (see samples 

on page 3). When you open a built-in workspace, it is pre-populated with widgets for the type of trading 

you have selected. 

To use a built-in workspace: 

1. From the main workspace File menu, select Save to save your current workspace. 

2. From the main workspace File menu, select Open. 

 
3. Choose your desired workspace and click Select. 

The current workspace closes and the selected workspace opens. 

Creating a new workspace 
When you create a workspace, you can start with a blank one or modify an existing workspace and save 

it as a new one. 

To create a workspace using a blank template: 

1. From the main workspace window's File menu, select New workspace. 
 
The existing workspace is closed, and a new, blank workspace main window is opened. 

2. Add and arrange widgets and windows as desired. 

3. From the File menu, select Save or Save as. 

The current workspace closes and is replaced by a new workspace. 

Saving a workspace 
To save the current workspace: 

• From the main workspace window's File menu, select Save, or 

• From the main workspace window's File menu, select Save as and specify a name for the 
workspace. 
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Widgets 
TradeStation FuturesPlus contains a number of widgets that provide various functionalities, such as 
market data displays and order entry capabilities. You can customize your trading experience by opening 
one or more widgets and configuring each widget to meet your needs. 

To open a widget: 

• Select a widget from the Widgets menu, or 
• Search for an instrument and open a widget, or 
• Find an instrument in the Market Explorer (Click Explore in the title bar) and open a widget, or 
• Open a widget from another widget. 

Several widgets, such as the Market Grid, 
Order Book, and Fills widgets, support tabs 
that allow you to provide multiple views of 
the data within a widget. For example, in an 
MD Trader widget, you could add tabs to 
show different instruments within a single 
widget instead of opening separate widgets 
for each instrument.  

In a Market Grid widget, you could use tabs 
to hold instruments for different market, as 
shown. 

The Widgets menu is a configurable menu that contains the default 
widgets as well as user-defined widgets. 

1. Favorites — Default and user-specified favorite widgets 
listed at the top for quick access. 

2. Widget menu categories — Sub-menus organizing the widgets 
by functional categories and for user-created custom widgets. 

3. Favorites indicator — Selectable indicators for identifying 
widgets to show in the top menu section. 
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Available widgets 
The following widgets are available in FuturesPlus: 

• Account List — Provides you the ability to quickly seed order entry screens and filter order and fill 
management widgets with specific accounts. 

• Audit Trail — Displays all of your historical account activity. 

• Balances — Displays your start-of-day and real-time account balance and margin requirements. 

• Chart — Displays historical market data in a variety of chart types and gives you the ability to add a 
multitude of technical indicators. 

• Fills — Displays all of your fills from the current trading session as well as from previous trading 
sessions. 

• Market Grid — Displays market data for multiple instruments in a grid-like format and gives you the 
ability to trade those instruments. 

• MD Trader — The industry-standard ladder displays market depth for a single instrument and gives 
you the ability to quickly and safely trade with a single click. 

• Options Chain — Displays a listing of the call and put option strike prices along with their premiums 
for a given maturity period. 

• Options Risk — Displays your open position in the options contracts and underlying futures 
contracts for a product on a per account basis. 

• Order Book — Displays all of your working orders and gives you the ability to cancel or modify those 
orders. 

• Positions — Displays your positions by account, exchange, or product. 

• RFQ Viewer — provides you with the ability to monitor and act upon an RFQ (request for quote) for 
an instrument. 

• Spread Matrix — Provides you the ability to view market data for multiple instruments and the 
spreads between those outright instruments. 

• Strategy Creation — Provides you the ability to create custom, user-defined strategies and submit 
them to the exchange. 

• Time & Sales — Displays trade activity for one or more instruments. 

• Trader Analytics — Gives a risk manager or trader the ability to analyze the current day’s trades and 
historical trade data from a comprehensive statistics report. 

• Vol Curve Manager — Displays multiple volatility curves for an underlying instrument and gives 
users the ability to create their own volatility curve. 

• Watchlist — Provides you with the ability to manage and monitor market data for selected options 
and futures instruments, as well as monitor Greeks and theoretical values of user-defined options 
strategies before submitting them to the market. 

https://library.tradingtechnologies.com/trade/al-account-list-overview.html
https://library.tradingtechnologies.com/trade/at-audit-trail-overview.html
https://library.tradingtechnologies.com/trade/chrt-charts-overview.html
https://library.tradingtechnologies.com/trade/fls-overview.html
https://library.tradingtechnologies.com/trade/mg-introduction-to-market-grid.html
https://library.tradingtechnologies.com/trade/mdt-overview.html
https://library.tradingtechnologies.com/trade/opc-overview.html
https://library.tradingtechnologies.com/trade/or-options-risk-overview.html
https://library.tradingtechnologies.com/trade/ob-order-book-overview.html
https://library.tradingtechnologies.com/trade/pos-positions-overview.html
https://library.tradingtechnologies.com/trade/rfq-viewer-overview.html
https://library.tradingtechnologies.com/trade/sc-strategy-creation-overview.html
https://library.tradingtechnologies.com/trade/ts-time-and-sales-overview.html
https://library.tradingtechnologies.com/trade/ta-trader-analytics-overview.html
https://library.tradingtechnologies.com/trade/vcm-overview.html
https://library.tradingtechnologies.com/trade/wl-watchlist-overview.html
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Widgets and grouping 
You can combine widgets into a widget group which can be sized and minimized like it was a single 

widget. After you create a widget group, you can add tabs within the group. 

To create a widget group: 

1. Open the widgets you want to put into a group. 

2. Right-click in the title bar of a widget, and select Create group widget. 

3. Drag the widget next to another widget, 

matching the edge color. 

The two widgets are combined into a single widget. 

To save a custom widget: 

4. In the custom widget, right-click in the title 
bar and select Save as custom widget from 
the menu. 

5. In the Save Custom Widget dialog, 
enter the following information: 

• Name for the widget, which is used in 
the widget title bar and in 
the Widgets menu. 

• Which icon you want to represent 
your custom widget. 

6. Click Save Widget. 
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Selecting a product to trade 

Searching for an instrument 

To search and find an instrument: 

 

1. Create or open a workspace, and then enter an exchange, product type, product, symbol, or 

instrument name in the Search box in the title bar. 

Tip: You can also enter keywords to search for an instrument (e.g., natural gas, soybeans, oil, 

etc.). 

In the search results, the market data is grouped and listed by product and instrument. The list 

of available products and instruments varies by exchange. 

2. Hover over the product name or instrument name to view a list of widgets that you can open.  

The available widgets will vary per product, product type, and instrument. For example, you can 

only launch an MD Trader for a specific product instrument. 

3. Click the widget to open it (e.g., MD Trader).  

Tip: Opening a widget for a product will open all available contracts (instruments) for that 

product. 
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Finding an instrument in Market Explorer 
To find an instrument in Market Explorer: 

 

1. Create or open a workspace, and then click Explore next to the Search box in the title bar.  

2. Select an Exchange, Type, Product, and Instrument.  

Tip: Use Shift-click to select multiple instruments for a product, or just select the product to 
open all instruments for that product. You can Ctrl-left click a selected value to unselect it.  

Check the Auto Roll checkbox to automatically roll the instrument after its expiry. 

3. Click a widget in the Widgets field.  

4. Click Select to open the widget containing the selected instrument.  
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Options Chain widget 
Use the Options Chain widget to quickly display a listing of the options for a given maturity along with 
their bids and offers. For the most liquid symbols on some exchanges, you can also view the volatility of 
call and put options available for the underlying futures contract and submit an order to buy or sell the 
option, as well as submit an order for the underlying. When opened in your workspace, the Options 
Chain displays strike prices in the center column, and displays premium prices for calls and puts in the 
left and right columns, respectively.  

      

The Options Chain displays the following: 

1. Product and Expiry — Shows the exchange, product symbol, and expiry that you selected for the 
options.  

2. Underlying instrument — Shows the instrument name as well as the best bid and ask prices and 
quantities for the underlying futures contract. 

3. Underlying price lock — Shows if the Options Chain is locked or unlocked for the underlying 
price entered in the lock field. 

4. Volatility — Columns that display volatility values for each options contract. 
5. Call data — Columns that display prices and quantities for Call options contracts.  
6. Put data — Columns that display prices and quantities for Put options contracts.  
7. Strike — Shows prices for exercising the option to buy or sell the underlying. 
8. Tabs — Allow you to add instruments for a single product in the Options Chain. Each tab shows 

the contract expiry. Each new tab that is added shows the next expiry for the product. 

 

 



13 
 

Trading from the Options Chain 
To trade call or put options contracts or the underlying futures contract directly from the Options Chain: 

1. Open the Options Chain widget from the Widgets menu. 

• It may not be a favorited widget. To access it, click Widgets, 
scroll over Options, and click Options Chain. 

2. A Market Explorer window opens. Choose which options you would 
like to trade. Click Select and the widget will load. 

3. Click any bid or ask within the options chain to launch a floating order 
entry widget with the corresponding put, call, or underlying futures 
contract at the specified price. 

• This floating order widget can be either an Order Ticket or MD 
Trader, depending on the preferences you have selected. 

4. To place a trade from the floating order entry widget (Order Ticket in 
this example): 

a) Enter the order quantity. 
b) Verify the account and order type. 
c) Click Buy or Sell to submit the order. 
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Strategy creation in the Options Chain 
From the Options Chain, you can create a synthetic options spread as a user-defined strategy in the 

Strategy Creation widget. These spreads can be published to the market by the exchange and made 

available from trading in the current trading session. 

The Options Chain provides quick access to the following commonly-used strategy templates as well as a 

custom item to define your own strategies. 

      

• Strip — Series of same-side orders for a range of consecutive months. 

• Calendar — Two opposite-side orders for different months. 

• Combo — Orders for both call and put options for the same strike price. 

• Combo Δ0 — Covered combo in which the options are hedged by the underlying instrument 

with a neutral delta. 

• Fly — Butterfly strategy with two legs equidistant from the leg on the opposite side. 

• Custom — User-defined combination of legs, quantities, and ratios. 

When you select one of the strategies, the Options Chain automatically ensures that strategies contain 

the proper relationship, quantities, and ratios for the strategy legs. For example, if you select a Combo 

strategy and select one end of the range, the Options Chain automatically adds all of the intervening 

legs. 
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In the Options Chain, you can also send an individual options contract to the Strategy Creation widget to 

facilitate building a strategy.  

To create a strategy from an individual options contract: 

1. Right-click the data unique to the call or put options contract. 
2. Select Open > Strategy Creation to open the widget seeded with the selected contract. 
3. Select a strategy template. 
4. Create your strategy. 

 
In addition, you can submit an RFQ for a single options contract in the Options Chain. Right-click the 

data unique to the call or put options contract and select Submit RFQ. 
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Market Grid widget 
The Market Grid displays market data for numerous instruments across multiple exchanges in a grid-like 

format and gives you the ability to quickly trade any of those instruments with an order ticket or MD 

Trader. You can organize the display of instruments to your liking by using tabs. You can also display 

market depth for an instrument with a simple mouse click. 

To open the Market Grid: 

• Select Market Grid from the Widgets menu, or 
• Search for a product or instrument in the title bar, select it, then click the Market Grid icon, or 
• Click Explore in the title bar, select an expiry, then click the Market Grid icon. 

There are settings available in the Market Grid widget that provide the ability to visualize instruments 

and market data activity. Users may add or hide columns to display various market data fields and can 

choose to expand the display of an instrument to display market depth. 

 

The Market Grid displays the following: 

1. Columns — Show or hide columns that are specific to your markets or instruments. 
2. Label Rows — Provide visual cues in a grid with many rows. 
3. Color rows by year — Differentiate instruments expiring in successive 12-month cycles. 
4. Highlight Updates — Highlight the Last, Bid, and Ask values when price updates occur. 
5. Tabs — Organize your instruments by showing and using tabs. 
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Creating a Market Grid with Market Explorer 
To use Market Explorer to launch a Market Grid: 

      

1. Click Explore on the workspace window menu bar. 

2. Select the Exchange, Type, Product, and Instrument you want to display. 

3. Check the Auto Roll checkbox to automatically roll the instrument after its expiry. 

4. Click Select. 

The Market Grid opens populated with market data for the selected instrument. 

Adding instruments to an existing Market Grid 
To add instruments to an existing Market Grid: 

1. Double-click any row within an existing tab in a Market Grid.  
2. Use Search or Explore to add one or more instruments to the Market Grid. Note that if you 

choose a product, all of the instruments available for the product are added to the Market Grid. 
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Trading from Market Grid 
You can trade from the Market Grid by opening an Order Ticket or MD Trader widget for the instrument 

you wish to trade. You can open a widget for a specific contract as a floating order entry widget, linked 

widget, or widget group. As you trade, your positions and working orders are displayed in the Market 

Grid. 

 

 

 

 

You can also middle-click the value in the Pos column to display your positions by account. 
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Floating order entry widget 
When you click a cell for an instrument's Bid/Ask Price, Bid/Ask Qty, or an open position, a floating order 

entry widget opens pre-populated with the selected value so you can quickly enter an order.  

Based on your preferences (which you can select from the Edit menu > Preferences > Orders > Floating 

order entry style > Order Ticket or MD Trader > Save), either an Order Ticket or MD Trader widget 

opens. The floating order entry style is Order Ticket by default. 
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Watchlist widget 
The Watchlist widget provides you with the ability to manage and monitor market data for selected 

options and futures instruments, as well as monitor Greeks and theoretical values of user-defined 

options strategies before actually submitting them to the market. Instruments added to the Watchlist 

persist over exchange sessions, which provides you with the ability to act upon them at any time. 

To open a Watchlist: 

• Click Widgets on the workspace tool bar, select Options > Watchlist, and search for an 
instrument, or 

• Right-click an instrument in the Market Grid, RFQ Viewer, Order Book, and Options Trade 
Monitor, and select Send to Watchlist in the context menu. 
 

The Watchlist displays the following: 

 

1. Contract column — Shows the options or futures instrument, exchange-defined strategy, or 
user-defined strategy sent to the Watchlist. 

2. Market data columns — Shows columns displaying market data and options Greeks (if shown) 
for the instrument or strategy sent to the Watchlist. Columns can also be shown for implied bid 
and ask quantities for Watchlist strategies that do not exist at the exchange. When displaying 
detailed depth, asterisks are displayed next to quantities that are partially or completely 
implied. 

Using the Watchlist to monitor and trade instruments and strategies, you can: 

• Create a user-defined strategy in the Strategy Creation widget and "send" the strategy to the 
Watchlist widget before submitting it to the market. 

• Select an instrument, exchange-defined, or user-defined options strategy in the Market Grid, 
select an instrument in RFQ Viewer, or select a trade in the Options Monitor and add it to the 
Watchlist. 

• View a strategy in the Watchlist and then send it to the Strategy Creation widget to modify and 
submit to the exchange. 

• Submit an RFQ for a futures or options contract or strategy from the Watchlist, or select an 
options strategy or instrument from the RFQ Viewer and add it to the Watchlist. 
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MD Trader widget 
MD Trader® is the industry-leading interface that provides single-click order entry for an instrument 

while displaying market depth against a static, vertical price axis. The static price display gives you a 

visual sense of market movement over a period of time or relative to other markets. 

When entering orders, MD Trader gives you the ability to quickly and safely enter orders for an 

instrument with a single click. The static price ladder gives you the confidence to enter an order at a 

specific price level, and the intuitive design of the widget allows you to manage your working orders and 

positions.  

To open MD Trader:  

• Select MD Trader from the Widgets menu, or 
• Search for a product or instrument in the title bar, select it, then click the MD Trader icon, or 
• Click Explore in the title bar, select an expiry, then click the MD Trader icon. 

 

MD Trader displays the following default items: 

1. Header Panel — Shows market data for the selected 
instrument for the current trading session, and also shows 
your position if the order pane is hidden.  

2. Order Entry Panel — Contains buttons and selectors for 
configuring, submitting, and canceling orders. Also shows your 
position. 

3. Work column — Displays the sum of all working orders at 
each price. Working buy orders are highlighted in blue, and 
working sell orders are highlighted in red. 

4. Bids column — Shows the aggregated bid quantities for a 
corresponding price level.  

5. Asks column — Shows the aggregated ask quantities for a 
corresponding price level.  

6. Price column — Displays prices for the instrument. 
7. Tabs — Allow you to add instruments to a single MD Trader. 

Each tab shows the contract month and position in that 
contract. 
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Trading with MD Trader 
MD Trader gives you the ability to quickly and safely enter orders for an instrument with a single click. 

The static price ladder gives you the confidence to enter an order at a specific price level, and the 

intuitive design of the widget allows you to manage your working orders and positions. 

To configure an order in MD Trader: 

1. Select the account, order type, time frame, and quantity you want to trade. 

2. Use the Bids column to place a buy order or the Asks column to place a sell order. Click in 

the cell that corresponds to the desired price. 

3. Any order that is not completely filled will be displayed in the work column. A working bid is 

in blue while a working ask is in red. 

4. To cancel all Asks and Bids, click the cancel working orders buttons. 
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Chart widget 
The Chart widget fully integrates charting and analytics on the TradeStation FuturesPlus platform by 

blending historical time series data with continuous real-time market data updates. The Chart uses the 

same price feed as the market data and order entry widgets (e.g., MD Trader), so the prices on the Chart 

are identical to what appears in those widgets. 

To open a Chart: 

• Select Chart from the Widgets menu in the title bar. 

• Search for a product or instrument in the title bar, select it, then click on the Chart icon. 

• Click Explore in the title bar, select an expiry, then click on the Chart icon. 
 

      

Charts display the following:  

1. Daily value box 

2. Charts menu 

3. Time axis 

4. Price axis 

5. Order pane 

6. Bids and Asks columns 

7. Market data for an interval (hover over a bar)  
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Chart trading 
The Chart widget provides you with the ability to enter orders directly within the chart, as well as 

monitor and interact with the markets by displaying fills and working orders. When you enable trading 

in a chart, an order pane is shown on the side of the chart for easy access to accounts, order types, time 

in force, position, and order quantity fields. Bids and Asks columns are placed within the widget for 

quick and easy single-click order placement. Filled and working orders are visible and actionable from 

within the widget. 

To enable chart trading: 

• Click  (the chart menu icon) in the top left corner of the chart and click  (the enable 
trading icon) in the Chart menu.  
 

Chart trading displays the following: 

      

When trading on a chart, you can: 

• Enter orders within the chart;  
• Display working orders and fills; 
• Modify working orders; 
• Cancel working orders; and 
• Display information for fills and working orders. 

 
Additionally, the Chart widget supports many technical indicators. The widget also allows you to add a 

technical indicator to another technical indicator (study on a study). Drawing tools are also supported. 

https://library.tradingtechnologies.com/trade/chrt-entering-orders-on-a-chart.html
https://library.tradingtechnologies.com/trade/chrt-displaying-fills-and-working-orders.html
https://library.tradingtechnologies.com/trade/chrt-modifying-working-orders-in-a-chart.html
https://library.tradingtechnologies.com/trade/chrt-canceling-orders-on-a-chart.html
https://library.tradingtechnologies.com/trade/chrt-displaying-fills-and-working-orders.html
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Account management 

Positions widget 
The Positions widget displays your positions (start-of-days [SODs] and any daily transactions) and 

profit/loss (P/L) across all of your accounts. 

To open the Positions widget: 

• Select Positions from the Widgets menu. 

 

The following columns display by default: 

• Account – Account number associated with the transaction. 
• Exch – Name of the exchange. 
• Product – Name of the product being traded. 
• Contract – The name and contract expiry for the instrument or strategy. 
• SOD - Your net position from the previous trading session. 
• BuyQty – Total quantity of Buys. 
• SellQty – Total quantity of Sells. 
• NetPos – Your net position. Calculated using your position from the previous trading session. 
• P/L - Total profit or loss. Calculated as P/L Realized + P/L Open. 
• AvgBuy – Average Buy price. 
• AvgSell – Average Sell price. 
• AvgOpen – Average price of your open position. 

  

From the Positions widget, you can use the right-click context menu to: 

• Open the MD Trader® widget, or 
• Use Settings to customize how you want to group and order your positions. 
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Orders and Fills widget 
The Orders and Fills widget helps you easily monitor and manage your working orders and fills. It 

combines the features and functionality of the Order Book, Fills and Positions widgets into a single 

widget. 

To open the Orders and Fills widget: 

1. Select Order Management from the Widgets menu. 
2. Select Orders and Fills. 

 

The Orders and Fills widget displays the following: 

1. The Order Book pane displays the working orders for all accounts visible to the user. 

2. The Fills pane displays the fills for every order selected in the Order Book pane, allowing you to 

focus quickly on fills for specific, individual orders. 

3. The Positions pane displays the positions for all fills displayed in the Fills pane, giving you a 

snapshot of the related positions and P/L. 

Note: You can hide the Fills and Position panes by selecting Hide from their respective right-click context 

menus. Selecting Show will restore a previously hidden pane. 
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Balances widget 
The Balances widget displays your start-of-day and real-time account balance and margin requirements.  

To open the Balances widget:  

1. Select Miscellaneous from the Widgets menu.  
2. Select Balances.  

The Balances widget displays the following: 

• Total Balance – Total cash account balance at the start of the day. 

• Collateral – The margin value of any securities (T-Bills) in the account, normally 95% of the face 

value. 

• Open Trade Equity – The open trade equity (marked to market profit and loss) on open positions 

based on the indicative settlement price. 

• Long Option Val – The net value of open long option positions. 

• Short Option Val – The net value of open short option positions. 

• Net Option Val – The net value of open option positions. 

• Liquidating Val – The value of the account if all positions were liquidated based on the estimated 

fill settlement prices. 

• Total Equity – The total trade equity (marked to market profit and loss) on open positions plus 

total balance. 

• Initial Margin Req – The margin equity needed to initiate new positions. It is used to calculate 

excess and deficiencies. Accounts that fall under maintenance are issued a call to initial margin. 

• Maintenance Margin Req – The minimum margin equity required to be maintained in an 

account. The maintenance margin requirement is the actual risk margin calculated by the 

Standard Portfolio Analysis of Risk (SPAN) margin system. 

• Total Margin Req – Total SPAN Requirement and the Net Option Value of the portfolio. 

• Margin Excess – The margin equity that the account has, in excess or deficit of initial margin 

requirement. 

• Margin Scale Up – The percent margin scale up. 
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Logging out 
To log out of the TradeStation FuturesPlus web application: 

1. Select the File menu from the main workspace window. 
2. Click Log out. 
3. Ensure that all changes made to your workspace have been saved. 
4. Confirm log out. 
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Help and Support 
TradeStation offers extensive online documentation and support to help you navigate the feature-rich 

FuturesPlus futures options web application. 

To find help: 

• Open the Support tab from the main workspace window menu bar. 
 

 

 

 

 

 

In addition, each widget in FuturesPlus has a help icon ("?") on its title bar that you can click to open 

help content specifically for that widget. The help widget that opens also provides access to additional 

online help topics.  

For additional assistance, log in to the TradeStation Client Center using your TradeStation account 

credentials. 

 

  

https://clientcenter.tradestation.com/Support/default.aspx?_gl=1*1bvd1kh*_gcl_dc*R0NMLjE1NTYxMTk0OTkuQ05tSjEtNkU2ZUVDRlRtbXhRSWRmSHNHV0E.&_ga=2.186565417.1400784964.1560798664-1940788539.1519248859
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Disclaimer  
IMPORTANT INFORMATION 

No offer or solicitation to buy or sell securities, securities derivatives or futures products of any kind, or 

any type of trading or investment advice, recommendation or strategy, is made, given or in any manner 

endorsed by any TradeStation affiliate. Past performance, whether actual or indicated by historical tests 

of strategies, is no guarantee of future performance or success. Active trading is generally not 

appropriate for someone with limited resources, limited investment or trading experience, or low risk 

tolerance. Please visit our website www. tradestation.com or www.tradestation-international.com for 

relevant risk disclosures. Equities, equities options, and commodity futures products and services are 

offered by TradeStation Securities, Inc. (Member NYSE, FINRA, CME and SIPC).  

Options trading is not suitable for all investors. Your account application to trade options will be 

considered and approved or disapproved based on all relevant factors, including your trading 

experience. View the document titled Characteristics and Risks of Standardized Options. Before trading 

any asset class, customers must read the relevant risk disclosure statements on our Important 

Information page. System access and trade placement and execution may be delayed or fail due to 

market volatility and volume, quote delays, system and software errors, Internet traffic, outages and 

other factors.  

 

©2019 TradeStation. All rights reserved. 

 

 

 

 

 

 

 

http://www.tradestation.com/
http://www.tradestation-international.com/
https://www.nyse.com/index
https://www.finra.org/
https://www.cmegroup.com/
https://www.sipc.org/
https://uploads.tradestation.com/uploads/Characteristics-and-Risks-of-Options.pdf
https://www.tradestation.com/important-information/
https://www.tradestation.com/important-information/

